Autodesk Navisworks — 4D simulatsiooni loomine

Ulesande piistitus
Antud juhendis vaatame Autodesk Navisworks naitel, mis on 4D simulatsiooni loomise péhisammud.
Selleks on meil kasutada Civil 3D DWG failid, kuid Iahtematerjalina véib selleks olla ka teised

Navisworks tarkvara poolt toetatud vormingud.

4D simulatsiooni loomise protsess
1. Kaivita Autodesk Navisworks tarkvara
2. ValiAppend ning lisa eelnevalt loodud AutoCAD DWG joonis(ed) oma projekti (eelkontrollitud,
tee-ehituskomponentideks jagatud)

Markus. Antud naiteks on meil selleks iiks koridormudel ja selle solids komponendid ning silla
komponendid (Civil 3D DWG joonis, algselt saaduna InfraWorks impordist)

Il  Viewpoint Review  Animation
% 2 E0E S
s @
Appen Refresh Reset_  File Select
i All.  Options B

Markus. Navisworks loob lingitavast failist n-6 cache faili, mis paikneb samas asukohas, kus ka
originaalfail ning omab faili laiendit *.nwc. Seeldbi saab projekti hiljem kiiremini avada. Kui see
kustutada, tuleb see uuesti luua. Seega peaks projektiga kaasama ka *.nwc failid (kui see edastatakse
just *.nwf failina). Tasub aga tdhele panna, et kui Navisworks projekti kausta teistega jagada, siis
vOidakse kisida, et millisest asukohast on lingitud failid leitavad, kuna need ei ole lldjuhul salvestatud
samasse kataloogi kui me teise osalisega neid jagame! Naidates uue asukoha ja salvestades uuesti
* nwf faili, ei pea me jargmisel korral enam neid asukohti uuesti nditama.

Markus. Olukorras, kus lahtefaili on vaja muuta ja see uuesti laadida, siis tuleb originaalfail Gle
kopeerida (meie naites siis *.dwg fail) ning Navisworks tarkvaras valida Home > Project > Referesh.

3. Sinu Selection Tree palett peaks seejarel ndgema valja alljargnev. Kliki + margil, et avada faili
alamstruktuur.

B Sild-VasakKallas.dwa
©(0) PGOO-Teostusmudel-Sild-v1.dwg.
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4. Seejarel kuvatakse Uksikud kihid/komponendid.

Markus. See on (iks olulisemaid l|dhtepunkte, et meil oleks kasutada failide struktuur ja
alamkomponentideks liigitus, mis ulatuses soovime neid kaasata 4D simulatsiooni.

Standard ~

= [8) sild-VasakKallas.dwg
# 4 SOLIDS - Sild-VasakKallas - Base
¥ SOLIDS - Sild-VasakKallas - Curb
# 4¥ SOLIDS - Sild-VasakKallas - Pavel
F ¥ SOLIDS - Sild-VasakKallas - Pave2
##F SOLIDS - Sild-VasakKallas - SubBase
# 4 SOLIDS - Sild-VasakKallas - Top_Dayli
©I[g) PGOO-Teostusmudel-Sild-v1.dwg
## C-BRDG-ABUTMENT
## C-BRDG-DECK
1 # C-BRDG-FOUNDATION
# 4% C-BRDG-GENERICOBIECT
## C-BRDG-GIRDER

@ C-BRDG-PIER

5. Sasaad osasid veel avada, + margist. Kui klikid Gksikul real, siis valitakse see objekt/objektid

6.

Standard
[ E[B) sild-vasakKall

o
a_agagalaaga?aaamqm@

ka joonisel. Naiteks C-BRDG-FOUNDATION.

SoLIDS - Sild VesakKells - Base
SOLIDS - ilé-VosakKells - Curb
SOLIDS - Sild-VasakKallas - Pavel
SOLIDS - Sild VesakKelle - Pove2
SOLIDS - Sild-VasakKallas - SubBase
SOLIDS - Sild VesakKells - Top_ eyl
00-Teostusmudel-Sild-v1.dwg
RO ABUTMENT

C-BRDG-DECK
CaRDGGENERICOBIECT
CaRDoSIROER

F ConoGPIER

Jargneval keskendume lihtsa 4D simulatsiooni koostamise pdhisammudele. Ava riba pealt
Home > Tools > TimelLiner

# BB

Links  Quick [Properties

S | B8

TimeLiner| Quantification

_»

Properties

Display

Kuvatakse 4D simulatsiooni loomise palett, TimeLiner

TimeLi

J Tasks | Data Sources | Configure | Simulate ‘

[Raoarase [ 22| - |2 | [Roaan- [ ] 2 | (8- [ | [ -2 [ &[] [ BB[E] 2o
Active | Status Mame Planned Start Flanned End Actual Start Actual End Task Typ
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8. Siin paletil me loome ehitustegevuse, seome selle mudeli komponendiga ja lisame selle
ehitustegevuse ajalise kestvuse (4D simulatsioon) ning soovi korral ka maksumuse (5D
simulatsioon). Iseseisvas t66s piirdume 4D simulatsiooniga.

9. Kliki nupul Add Task. Luuakse uus rida allolevasse tabelisse.

TimeLiner

Tasks Data Sources [ Configure 1 Simulate |

| Sladd Task | 2 | - | 5 || Ry Atach - | 55 | 5 |

Bctive Hame Status | Planned Start . Planned End

10. Lahtuvalt valitud projektist, nimeta ka ehitustegevuse tldine nimetus sellele vastavalt (lihtsalt
vali rida, mille Name vaartust soovid muuta, tee veel Uks aeglane vasak klikk, et saaksid
nimetuse dra muuta). Vajutades ENTER, luuakse automaatselt uus rida.

Tasks :Data Sources I Configure [ Simulate |
'QﬁddTasklggl'?'||-_'g||%Attachv | 56 | &k |

Active Name Status Planned Start  Planned End
B Rabala = NA M/
B NewTask = INA_____INA_____
11. Vastavalt mudelile lisa igale komponendile oma rida (seosed tekitame hiljem). Seega, iga

koridormudeli kohta lisame hetkel 6 tegevusrida. Tegevusi saad Uksteise suhtes Umber
reastada nditeks Move Up ja Move Down nupuga.

. Tasks Data Sources l Configure 1 Simulate |

| RaddTosk | 2| - | R | oaecn - | 8| 6|89~ (B[ B

Move Up
Active Maove the selected tasks up the task list. Tasks can f End
—| onky mowve within their current level of hierarchy.
B Raba-lai ¥ i

12. Lisa ka kindlat osamudelit koondav tegevusrida. Naiteks allolevalt on loodud rida VasakKallas,
mille alt leiab sellega seotud tegevused. Tegevuste koondamiseks peagrupi alla kasuta valikut
Indent.
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| ook | 8| - | R [ Rovecn | 56 [ G| (88| B = [R] |
Indent
Active Mame Indent the selected tasks by one level in the task Star
hierarchy.
(] Raba-Lai = = =
B  vasakkallas = N/A N/A N/A

Sild-VasakKallas-SubBase
Sild-Vasakiallas-Base

Sild-VasakKallas-Pave2
Sild-Vasakiallas-Pave]

13. Seejarel on meil koridormudelist VasakKallas omaette tegevusgrupp, mida saab ka

koondada/avada.
Active Marme Status  Planned Start  Planned End  Actual Start A:T? End | Task
B rabala = N& M/A N/A /A

a8 sild-VasakKallas-SubBase = N/A NfA N/A HiA
B  sid-vasakKallas-Base = NfA N/A NJA N/A
] Sild-VasakKallas-Pave? = N M/A N/A M/A
. Slle-Vasakkallas-Pavel = NA NfA M/A N/A

14. Loome sarnaselt ka sillale/viaduktile tegevusread ja grupeerime need uhise peagrupi alla.
Allpool on eeldatud, et naiteks kdik Ghte liiki objektid on liks grupp, samas on selge, et
tegelikult véidakse need vilja ehitada vaga erinevatel aegadel/perioodidel ja sellisel juhul
saame ka iga komponendi/elemendi kohta koostada oma kindla tegevusrea. Jarjesta need
loogiliselt, ehk siis esmalt naiteks FOUNDATION, seejarel PIER, ABUTMENT voib olla enne voi
parast ja seotud naiteks vagagi koridormudeliga.

Active Mame Status  Planned Start | Planned End
B  Rabala = N/A N/A

B  vasakKallas - N/A N/A
O - | Sild-vasakkallas-SubBase = NA NfA

B  sid-vasakKallas-Base = N/A /A

] Sild-vasakkallas-Pave? = N/A NfA

B  sid-vasakKallas-Pavel - N/A N/A

B sild = N/A NfA

Silg-Beanngs
Sild-Girder

Sild-Deck

15. Jargmise sammuna seome mudeli komponendid (kihid) ehitustegevusega. Liigu Selection Tree
paletile. Vali SubBase |Gpuga rida, hoia vasakut hiire nuppu all ning tiri see vastava tegevusrea
peale ja lase hiirenupp lahti (TimeLiner paletil). Lase hiire nupp lahti. Sellega me seome éra,
et ehitustegevus SubBase ja vastava mudeli osakomponendid. Hetke ndites on meil
samavaarsed nimetused, kuid ei pruugi.
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Markus. Sidumist naitab ka veerg Attached, kus siis marge Explicit Selection, mis lihtsalt viitab sellele,
et me oleme jooniselt valinud mingid komponendid ja 6elnud, et need kuuluvad selle tegevuse juurde.

Neid voib olla ka mitmeid ridasid Selection Tree vaoi siis mudelist valituna.

Selection Tree

Standard v

| @B Raba-Lai.nwd

©[3) sild-VasakKallas.dwg
(0¥ SOLIDS - Sild-VasakKallas - Base
(0§ SOLIDS - Sild-VasakKallas - Curb
@ 4F SOLIDS - Sild-VasakKallas - Pavel
= & SOLIDS - Sild-VasakKallas - Pave2
oF - Sild-Vasaljallas -
@ ¥ SOLIDS - Sild-VasakKallas - Top_Di

=[3) PGOD-Teostusmudel-Sild-v1.dwg
08 C-BRDG-ABUTMENT
04 C-BRDG-DECK
@5 C-BRDG-FOUNDATION
@i C-BRDG-GENERICOBIECT
0% C-BRDG-GIRDER
@4 C-BRDG-PIER

: Tasks tDala Sources I Configure ] Simulate |

iq,wuaskig%i!?-|q][%amhvi%i&i@

Active

Raba-Lai
VasakKallas

Sild-VasakKallas-SubBase

Sild-vasakKallas-Base
Sild-vasakKallas-Pave2
Sild-VasakKallas-Pavel

N/A /A
NJA /A
NJA /A
N/A N/
NJA /A

BelE] BEEE =

Status Planned Start | Planned End ~ Actual Start

N/A
N/A

N/A
NfA
N/A

Actual End  TaskType  Attached  Total o)
N/A

s

N/A

N/A

N/A

16. Toimi sarnaselt lGlejadnud komponentidega.

17. Seega peaks koik sinu tabeli read (va peagrupid) olema seotud mudeli komponentidega ning
veerg Attach kuvama marget Explicit Selection.

Active Name

VasakKallas
Sild-vasakKallas-SubBase
Sild-VasakKallas-Base
Sild-Vasakkallas-Pave2
Sild-VasakKallas-Pavel
Sild

Sild-Abutrment
Sild-Foundation
Sild-Fier

Sild-Bearings
Sild-Girder

Sild-Deck

Status Planned Start  Planned End  Actual Start

N/A
N/A
N/A
N/A
N/A
N/A
N/A
N/A
N/A
N/A
N/A
N/A

N/A
N/A
N/A
N/A
N/A
N/A
N/A
N/A
N/A
N/A
N/A
N/A

N/A
N/&
/A
NfA
N/A
N/&
N/A
N/&
/A
NfA
N/A
N/&

N/A
N/A
/A
N/A
N/A
N/A
N/A
N/A
/A
N/A
N/A
N/A

Actual End  Task Type

Attached

Explicit Selection
Explicit Selection
Explicit Selection
Explicit Selection

Explicit Selectian
Explicit Selection
Explicit Selection
Explicit Selection
Explicit Selection
Explicit Selection

18. Salvesta Autodesk Navisworks projekt, klikkides nupul Save. Anna nimetuseks naiteks: PG00
— 4D-simulatsioon.nwf (faili salvestamisel veendu, et faili laiendiks on *.nwf).

19. N{ld lisame veel ajalise md6tme ehk tegevuse kestvuse. Lahtume Uldistest pdhimd&tetest ning
detailidesse nendega ei lasku. Seega kasutame iga tegevuse nn elluviimiseks sama ajamastaapi
—naiteks 1 nadal. Lihtsalt taida sellest printsiibist [ahtuvalt veerud Planned Start ning Planned
End. Alloleval pildil on naha, et k&ikide tegevuste kestvus on 1 naddal, ning jargmine tegevus

algab samal pdeval, millega eelmine |6peb. Alustatud on sillast.
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Active MName Status | Flanned Start | Planned End  Actual Start | Actual End  Task Type Attached

B  Rabalas = NA /A /A N

. - Sild = 08.04.2024 19.05.2024  N/A MN/A

. Sild-Abutment = 08.04.2024 14.04.2024  N/A MJA Explicit Selection

. Sild-Foundation = 15.04.2024 21.04.2024  N/A N/A Explicit Selection

. Sild-Pier = 22.04.2024 28.04.2024 N/A N/A Explicit Selection

. Slld-Bearings = 29.04.2024 05.05.2024  N/A /A Explicit Selection

. Sild-Girder = 06.05.2024 12.05.2024  N/A MJA Explicit Selection

. Sild-Deck = 13.05.2024 19.05.2024 N/A M/A Explicit Selection

a VasakKallas = 20.05.2024 16.06.2024  N/A N/A

. Sild-VasakKallas-SubBase = 20.05.2024 26.05.2024  N/A /A Explicit Selection

. Sild-VasakKallas-Base = 27.05.2024 02.06.2024  N/A N/A Explicit Selection

. Silel-Y asak K allas-Pave? = (03.06.202 09.06.2024  N/A M/A Explicit Selection
. Sild-VasakKallas-Pavel ( 1 ) xplicit Selection

20. Kuna ehitustegevusi on erinevat liiki (nt ajutine ehitis, ehitamine, lammutamine), siis tuleb ka

21.

meil tegevustele markida, millega tegemist. Selleks margi veerus Task Type koikidele
tegevustele (va esimene rida), et need on Construct tiipi.

Active Mame Status | Planned Start | Planned End = Actual Start | Actual End  Task Type
B rabala = N/A h/A N/A h/A
= |08.04.2024 19.05.2024 e
- Sild-Abutment = 08.04.2024 14.04.2024  N/A M _
] sild-Foundation = 15042024 21.04.2024 NJA NfA Construct
- Sild-Pier = 22.04.2024 28.04.2024  NJA M/a Demolish
- Sild-Bearings = 29.04.2024 05.05.2024 N/A MfA empora
Active Mame Status  Planned Start  Planned End  Actual Start | Actual End  Task Type Attached
B  Rabala = NA N/A N/A NfA
. - Sild = 08.04.2024 19.05.2024 N/A A Construct
. Sild-Abutment = 08.04.2024 14.04.2024 N/A MN/A Construct  Explicit Selection
B  sid-Foundation =  15.04.2024 21.04.2024 N/A N/A Construct  Explicit Selection
. Sild-Pier = 22.04.2024 28.04.2024¢ N/A N/A Construct  Explicit Selection
B  sild-Bearings = 29042024 05052024 N/A N/A Construct  Explicit Selection
. Sild-Girder = 06.05.2024 12.05.2024  N/A N/A Construct  Explicit Selection
B  sidDeck = 13052024 19.05.2024 N/A N/A Construct  Explicit Selection
. VasakKallas = 20.05.2024 16.06.2024  N/A N/A Construct
. Sild-VasakKallas-SubBase = 20.05.2024 26.05.2024  N/A A Construct  Explicit Selection
. Sild-\asakKallas-Base = 27.05.2024 02.06.2024  N/A N/A Construct  Explicit Selection
. Silel-VasakKallas-Pava2 = 03.06.202 09.06.2024  N/A A Construct  Explicit Selection
. Sild-VasakKallas-Pavel = (10.06.2024 [16.06.2024 |N/A M/A Construct  |Explicit 5 ion

Simulatsiooni peatasandit (Raba-Lai) kasutame selleks, et sellega seome nii EHRI IFC faili kui
ka olemasoleva maapinna (DWG fail, eksporditud originaalfailist eraldiseisvasse faili)

Standard
5[} PG00-Teostusmudel-Sild-v1.dwg

E C-BRDG-ABUTMENT

§ C-BRDG-DECK

£ C-BRDG-FOUNDATION

£ C-BRDG-GENERICOBJECT

¥ C-BRDG-GIRDER

F C-BRDG-PIER

sild-VasakKallas.dwg

Lai-Riia.dwg

£ SOLIDS - Lai-Riia - Base

£ SOLIDS - Lai-Riia - Curb

£ SOLIDS - Lai-Riia - Pavel

£ SOLIDS - Lai-Riia - Pavez

£ SOLIDS - Lai-Riia - SubBase
@ SOLIDS - Lai-Rila - Top_Daylight_Day

[3) Pipe-Network.dwg

Lz
S C-TINN-VIEW

Jo:]
peecaeasaas

(5 AIW_Existing_Ground (1)

L1z ou2-ca71787.0-sa0383.0.0d

TimeLiner ax

Tosks | Data Sources | Gonfgure | simulte |
Stk [ 2[R [ [Rree [B]R) (] [F 255 R[] BEEE =~ 0 (]88

mai 2024 Juuni 2024
Total ot e

w21 w22 w23 w2e w

— 08042024 14042024 NA NA Construct. Explict Selection
= 15042024 21.04.2024 N/A N/A Construct  Explicit Selection
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22. Neile, olemasolevatele defineerime omaette Task Type tiilbi. Seega, olles TimelLiner paletil,

vali Configure paan ning lisa uus Task Type, nimeta see kui Olemasolev, seadista parameetrid
alloleva pildi kohaselt, ehk siis kasutame labivalt mudeli enda varvitoone.

TimeLiner
Tasks | Data Sources | Canfigure | Simuate
| ‘ E¥Delete ‘ Appearance Definitions.
[Add Configuration :
[Add a new task type configuration. Start Appearance End Appearance Early Appearance Late Appearance Simulation Start Appearance
Tonstruct Green (90% Transparent) Model Appearance None None None
Demolish Red (80% Transparent) Hide None None Model Appearance
Temporary Yellow (90% Transparent) Hide None None None
Model Appearance Model Appearance Mocel Appearance Maodel Appearance Model Appearance

23. Veendu, et esimesele reale oleks see Olemasolev ka valitud

| Tasks :Dala Sources I Configure 1 Simulate |

(et e~ - =2 [g@- ? 7 =
| Rndd ok | 22 | R | R | Ronech- | 5 | ) (22 & 2] (@] (@]
MName Status Planned Start  Planned End = Actual Start | Actual End  Task Type
= |08.04.2024 16.06.2024 |N/A Olemasolev
sild =  08.04.2024  19.05.2024 N/A M/A Cond
Sild-Abutment = 08.04.2024 14.04.2024  N/A MfA Construct

Markus. Sa void soovida vaateakna tausta dra vahetada. Liigu riba paanile View > Scene View >
Background ning avanevas dialoogis vali Mode = Horizon.

| View Output BIM 260 Glue Render

| —
g [ |lod2-6471855.0-530102.0 - PR

Mode & Levell - Alignment

Eﬁ Background
.y

Hw Size

Background Settings :l
v Title Bars

| Sets the background color and style of the scene.
Grids & Levels u | Civil Align

24. Liigu nlld paanile Simulate

TimeLiner

Tasks l Data Sources 1 Configure | Simulate ‘

25. Kaivita 4D simulatsioon, klikkides Play nupul

Tasks I Data Sources I Configure | Simulate ‘

LA

Play Eattings 09:00

Play the simulation from the current position. |_‘g| 08.04.2024
i |

26. Tee-ehitusprojekti hakatakse simuleerima. Simulatsiooni kdigus void vabalt mudelis ringi
liikuda (navigeerida, suurendada/viahendada).
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esmaspaev 12:21:18 29.04.2024 Day 22 \Week 4

Markus: Komponentidele on véimalik peale panna realistlikud materjalid, et visualiseerimise aspektist
see suuremat efekti omaks. Samuti on vdimalik muuta varvitoone, mismoodi kuvatakse need objektid,
mis on ehitusetapis (nt siin ndites rohelise tooniga).

Markus: Simulatsiooni on voimalik salvestada videofailina, et seda edastada erinevatele osalistele.
Lisaks saab Autodesk Navisworks faili jagada nn Autodesk Navisworks Viewer paketi vahendusel.

27. Salvesta projekt.
28. Salvesta projekt ka teises formaadis. Selleks, kliki N > Save As.

29. Avanevas dialoogis veendu, et niitid valid faili titbi *.nwd. Kliki Save.

Markus: NWF fail sisaldab linke algfailidele (nt meie ndites AutoCAD *.dwg failile), mistdttu selle
edastamine ilma *.dwg failita on kasutu. Seevastu NWD faili integreeritakse koik lingitud failid sisse.
Mdlemal on omad eelised.
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